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Before using this information, be sure to read the general information under Appendix B: 
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Introduction 
 
The following topics are covered in this section: 
 
• About the IBM® Rational® Synergy for Microsoft® Source Code Control Interface™  

 
• How the Interface works 

 
• Audience 

 
• Contacting IBM® Rational® Software Support 
 

 
About the IBM Rational Synergy for Microsoft Source 
Code Control Interface 
 

The IBM Rational Synergy for Microsoft Source Code Control Interface supports 
PowerBuilder® version 10.5. It allows you to set up and control your PowerBuilder 
application in the IBM® Rational® Synergy™ repository. The interface provides 
configuration management support through insulated and build management areas, task-
based CM support, and source code control operations on library entries directly from the 
PowerBuilder. This interface does not work with earlier versions of PowerBuilder. 
 
•  Assumptions 

 
•  Features 
 

Assumptions 
  

Before using this document, you should have a basic understanding of how to use 
PowerBuilder and IBM Rational Synergy. If you are unfamiliar with PowerBuilder, you 
should work through the PowerBuilder tutorial.  
 
You should also have a conceptual and practical understanding of IBM Rational Synergy. 
You should understand task-based CM and be able to perform developer or build 
manager operations. A tutorial is also available for IBM Rational Synergy. 
 
If you need more information about IBM Rational Synergy, refer to the following 
documentation, which is available on the IBM Rational Synergy Support web site 
(http://www.ibm.com/software/awdtools/synergy/support/): 
 
• For terms, concepts, and methodology, see Introduction to IBM Rational Synergy. 
• For information about developer-level operations, refer to the IBM Rational Synergy 

Tutorial. 
• For information about build management-level operations, see the Build Manager’s 

Guide. 
• For a description of IBM Rational Synergy dialogs, commands, and default settings, 

see the IBM Rational Synergy Help. 
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Read this entire document before using the interface. Knowing all of the features 
before you integrate your data will help ensure a seamless, efficient integration. 

 
Features 
 

The interface allows you to use the source code control operations from the PowerBuilder 
10.5 integrated development environment (IDE). 
 
This release includes the following information about converting or upgrading from 
previous releases: 
 

• Converting a IBM Rational Synergy for Microsoft Source Code Control Interface 
running a PowerBuilder version prior to 10.5. This allows you to convert your 
custom integration project into the SCC multiple project structure. For specific 
instructions about the conversion process, refer to Appendix A – Conversion 
Process for PowerBuilder SCC Projects. 
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How the interface works  

 
PowerBuilder Version 10.5 has a source control interface that uses the Microsoft® 
Microsoft Source Code Control Interface (MSSCCI) Microsoft Application Programming 
Interface (MAPI) to request services from SCC provider dynamic link libraries (DLLs). 
 
With PowerBuilder 10.5, there is no need for shared PowerBuilder Source Code Libraries 
(PBLs) to be on a shared network. All that is required now is a local PBL. The SCC tool is 
now a repository. The Local Root Directory and SCC Working Folder should be the 
same. 
 
Version control menu items, such as check in and check out, are built into PowerBuilder’s 
Library Painter and System View. Each requested operation is transacted in the 
foreground by PowerBuilder; IBM Rational Synergy operates in the background. 
Additional configuration management operations are available in the Advanced dialog 
box. More advanced operations are available outside of the application programming 
interface (API) from the IBM Rational Synergy interface. 

 
Audience 

 
The IBM Rational Synergy for Microsoft Source Code Control Interface with PowerBuilder 
is for PowerBuilder developers and build managers. 

 

Contacting IBM Rational Software Support 
If the self-help resources have not provided a resolution to your problem, you can contact IBM® 
Rational® Software Support for assistance in resolving product issues. 

Note: If you are a heritage Telelogic customer, a single reference site for all support 
resources is located at http://www.ibm.com/software/rational/support/telelogic/ 

Prerequisites 

To submit your problem to IBM Rational Software Support, you must have an active Passport 
Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive 
software licensing and software maintenance (product upgrades and technical support) offering. 
You can enroll online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html 

•     To learn more about Passport Advantage, visit the Passport Advantage FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html. 

•      For further assistance, contact your IBM representative. 

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you 
must additionally: 

•      Be a registered user on the IBM Rational Software Support Web site. For details about 
registering, go to http://www.ibm.com/software/support/. 
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•      Be listed as an authorized caller in the service request tool. 

Submitting problems 

To submit your problem to IBM Rational Software Support: 

1.    Determine the business impact of your problem. When you report a problem to IBM, you are 
asked to supply a severity level. Therefore, you need to understand and assess the business 
impact of the problem that you are reporting. 
 
Use the following table to determine the severity level. 

Severity Description 

1 
The problem has a critical business impact: You are unable 
to use the program, resulting in a critical impact on 
operations. This condition requires an immediate solution. 

2 This problem has a significant business impact: The 
program is usable, but it is severely limited. 

3 
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable. 

4 
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented. 

 

2.    Describe your problem and gather background information. When describing a problem to 
IBM, be as specific as possible. Include all relevant background information so that IBM 
Rational Software Support specialists can help you solve the problem efficiently. To save 
time, know the answers to these questions: 

•      What software versions were you running when the problem occurred? 
To determine the exact product name and version, use the option applicable to you:  

o     Start the IBM Installation Manager and select File > View Installed Packages. 
Expand a package group and select a package to see the package name and 
version number.  

o     Start your product, and click Help > About to see the offering name and version 
number.  

•      What is your operating system and version number (including any service packs or 
patches)?  

•     Do you have logs, traces, and messages that are related to the problem symptoms?  

•     Can you recreate the problem? If so, what steps do you perform to recreate the problem?  

•      Did you make any changes to the system? For example, did you make changes to the 
hardware, operating system, networking software, or other system components?  
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•      Are you currently using a workaround for the problem? If so, be prepared to describe the 
workaround when you report the problem. 

3.    Submit your problem to IBM Rational Software Support. You can submit your problem to IBM 
Rational Software Support in the following ways: 

•      Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational support task 
navigator, click Open Service Request. Select the electronic problem reporting tool, and 
open a Problem Management Record (PMR), describing the problem accurately in your 
own words. 
 
For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html 
 
You can also open an online service request using the IBM Support Assistant. For more 
information, go to http://www.ibm.com/software/support/isa/faq.html. 

•      By phone: For the phone number to call in your country or region, go to the IBM  
   directory of worldwide contacts at http://www.ibm.com/planetwide/ and click the name of   
   your country or geographic region.  

        •     Through your IBM Representative: If you cannot access IBM Rational Software  
    Support online or by phone, contact your IBM Representative. If necessary, your IBM  
   Representative can open a service request for you. You can find complete contact  
   information for each country at http://www.ibm.com/planetwide/. 
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Product requirements 
 
The following products are required to run the IBM Rational Synergy for Microsoft Source 
Code Control Interface with PowerBuilder: 
 
• PowerBuilder 10.5 

 
• IBM Rational Synergy 7.1 server on UNIX® or Windows® 

 
• IBM Rational Synergy 7.1 client on Windows XP Professional Service Pack 2 or 

Windows Vista 
 

• IBM Rational Synergy for Microsoft Source Code Control Interface 2.1 
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Installation instructions  
 
The following sections explain how to install the interface: 
 
•  Install and set up PowerBuilder 

 
•  Install the interface 

 
•  Install PowerBuilder file types 

 
•  Verify PowerBuilder file types installation 

 
•  Configure PowerBuilder JRE 

Install and set up PowerBuilder 
 

This section explains how to install and set up PowerBuilder 10.5. 
 

PowerBuilder 10.5 
 

Install PowerBuilder 10.5. The SCC interface is included by default. Check to be sure that 
it is selected by clicking Details in the Products Available page. 
 

Install the interface 
 

To start the installation process:  
 

1. Go to the IBM Rational Synergy Support Web site, 
http://www.ibm.com/software/awdtools/synergy/ to ensure that you 
have the latest version of the setup.exe file for the IBM Rational Synergy for 
Microsoft Source Code Control Interface. 

If a newer version of the interface exists, download it from the Support Web site, and 
then extract it. 

For more information about the Support Web site, see “Contacting IBM Rational 
Software Support”. 

2. Double click the setup.exe file. 
 
The Choose Setup Language dialog appears. 
 

3. Select the setup language and then click OK. 

The Welcome dialog appears. 

4. Click Next. 

The License Agreement dialog box appears. 
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5. Read and accept the terms in the license agreement, and then click Next. 

The Destination Folder dialog box appears. 

6. Verify the installation path, and then, if the path is correct, click Next. 

If you need to change the path: 

a) Click Change. 

The Change Current Destination Folder dialog box appears. 

b) In Look in, navigate to and select the correct path, and click OK to close 
the Change Current Destination Folder dialog box. 
 

c) Click Next. 

The Ready to Install the Program dialog box appears. 

7. Click Install. 
 

8. When the Installshield Wizard Completed dialog box appears, click Finish. 
 

9. Start a IBM Rational Synergy session on your production database. 

 

Install PowerBuilder file types 
 

PowerBuilder file types must be installed into each IBM Rational Synergy database. To 
install these types, you must have ccm_admin privileges.  
 
To install PowerBuilder file types: 

 
1. From the command prompt, go to IBM Rational Synergy 7.1 installation bin 

directory. 
 

2. Start the IBM Rational Synergy Classic Client 
 
ccm start –n host name –d database path 

 
3. Set your role to ccm_admin. 

 
4. From the command prompt, run the pbtypes_install.bat file, which is located 

by default in C:\Program Files\IBM\Rational\Synergy for MSSCCI\bin. 
 

5. After the installation is completed, exit and restart your IBM Rational Synergy 
session. 
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Verify PowerBuilder file types installation 
After you have installed the PowerBuilder file types, restart your IBM Rational Synergy 
session and verify that they were properly installed. 

1. From the command prompt, go to the IBM Rational Synergy 7.1 installation bin 
directory. 
 

2. Start the IBM Rational Synergy Classic Client. 

ccm start -n host name -d database path 

3. Set your role to type_developer. 
 

4. From the main menu, select Admin > Type Definition. 

The Type Definition dialog box appears. 

5. Click Browse Types. 

The Type Browser dialog box appears. 

6. Scroll to find the pb_type types. 
 

7. Click OK. 

 

Configure PowerBuilder JRE 
 

PowerBuilder must be configured to use JRE 1.6 in order to work with IBM Rational 
Synergy for Microsoft Source Code Control Interface 2.1. Follow these steps to configure: 
 
1. Install JRE 1.6. 
 
2. Rename the existing JRE folder from PowerBuilder under the PowerBuilder 

installation directory. 
By default, it is C:\Program 
Files\Sybase\Shared\PowerBuilder\jdk1.4.2_06\jre. 

 
For example, rename  
 
C:\Program Files\Sybase\Shared\PowerBuilder\jdk1.4.2_06\jre  
 
to  
 
C:\Program Files\Sybase\Shared\PowerBuilder\jdk1.4.2_06\jre_org 

 
 
3. Replace the JRE with the JRE 1.6 under the PowerBuilder installation directory. 

By default, it is C:\Program 
Files\Sybase\Shared\PowerBuilder\jdk1.4.2_06\jre. 
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Project setup and data migration 
 

This section describes the initial project setup and data migration, which includes the 
following steps: 

 
1. Build your application in PowerBuilder  

 
2. Migrate the project to IBM Rational Synergy 

 
3. Rebuild and baseline your project 

 
4. Set up a development project  

 
5. Set up a build management project  

 
6. Releasing a project 

 

Build your application in PowerBuilder  
 

PowerBuilder 10.5 works effectively with source code control if PBL files are placed in 
their own folders. Place only one PBL file in each folder.  
 
1. Create your Workspace.  

 
2. Inside your Workspace folder, create a subfolder for each PBL file you wish to 

include in the Workspace.  
 

3. Create or copy PBL files into these folders.  
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If you want to use PBL files already present in IBM Rational Synergy, first you need 
to migrate your project.  For more information, see Migrate project to IBM Rational 
Synergy. 
 

 
4. Once the PBL files have been migrated, open IBM Rational Synergy Classic Client, 

and open your project.  
 

5. Select the folder that should contain the PBL file.  
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6. Check out the project, and then select from the menu Add Object.  
 

7. In the Add Object dialog box, use Query to find the required PBL file. 
 

8. Select the file, and then click Add.  
 

9. Check out the PBL file even if you do not want to modify it. 
 
Now you can rebuild your project again.  

 
10. Build your project. 

 
Build all the executables and DLLs that you wish to control in IBM Rational Synergy.  

 

Migrate the project to IBM Rational Synergy 
Before you can use source code control operations on the PowerBuilder project, you or 
another user (such as the CM administrator or the build manager) must migrate the project 
into the IBM Rational Synergy database. 

1. If PowerBuilder file types are not installed already, install them now. 
 
Refer to IBM Rational Synergy for Microsoft Source Code Control Interface 2.1 
installation instructions.  
 

2. If the project that you want to migrate is open in PowerBuilder, close it. 
 

3. Start a IBM Rational Synergy Classic Client session. 
 

4. From the IBM Rational Synergy Classic Client main menu, select Tools > Migrate.  
 
The Migrate dialog box appears. 

 
5. Select Browse to find the directory where your project is located, and then type the 

name and version of the project into which you are migrating the PowerBuilder 
project. 

 
6. In Project field, type the project name using the project name, delimiter, and version 

format. For example, projname-version. 
 

7. Select a task. 
 

8. Click Preview. 
 
The Preview operation causes all of the files that you are migrating to be evaluated 
according to the migrate rules. These rules are used by IBM Rational Synergy to 
assign types to the files and to ignore types of files that should not be migrated. You 
can add to or change the rules using the Options menu Set option. 

 
9. If you want to change any of the file types or ignore any of the files that would 

otherwise be migrated, select them, and then make the changes before performing 
the next step, which is loading the files. 
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Note  If there are characters in any of the file names that are restricted by 
IBM Rational Synergy, you will receive a warning message. You should 
change the file names before performing the load or the files will not be 
migrated. See the General Usage section of the IBM Rational Synergy Help 
for the list of restricted characters. 

10. Select Work Area Properties to choose your work area as desired. 
 
11. Click Load. 

 
This operation assigns a type to and loads each file listed in the Preview Results into 
the IBM Rational Synergy database. For more information on the migrate operation, 
see the IBM Rational Synergy Help. 

 
12. Complete the Migration operation, and then select File > Close when the migrate 

operation is complete. 
 

Although the data is now in a project, do not check in the project at this time. You will 
be making several more modifications before your project is ready to become the 
baseline project. 

 
13. Remove the directory from which you migrated data. 

 
This can lessen confusion later, as the data is located in only once place: the IBM 
Rational Synergy project in which it has been migrated. 

 
 

Rebuild and baseline your project 
 

Your project is now in IBM Rational Synergy.  Perform the following steps to baseline the 
project. 

 
1. From IBM Rational Synergy, check out all PBW, PBT, PBL, EXE and DLL files.  

 
2. Open PowerBuilder, and then open the project workspace. 

 
3. Select the workspace, right click and select Properties. 

 
The Properties of Workspace dialog box appears. 
 

4. Select the Source Control tab. 
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5. Select Synergy in the Source Control System list. 

 
6. Specify your User ID and Project information. 

 
7. Click Connect. 

 
8. The IBM Rational Synergy Startup Info dialog box appears. 

Specify the corresponding information. 
 

9. Click OK. 
 
Now your PowerBuilder project is connected with the IBM Rational Synergy database. 

 
10. Click OK.  

 
11. In PowerBuilder, select the workspace, right click and select Refresh Status.  

 
12. Select all files from the Refresh Status dialog and click OK. 

 
This refreshes the source control status on the workspace.  

 
13. Rebuild your application. 
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14. Select the workspace, right click and select Add to Source Control from the Workspace 
menu. 

 
15. Select all files from the Add to Source Control dialog and click OK. 

 
This exports all the library entries and adds to IBM Rational Synergy database. 

 
16. Refresh status by selecting Refresh Status from the Workspace menu. 

 
17. Select the workspace, right click and select Properties. 

 
The Properties of Workspace dialog box appears 

 
18. Select the Source Control tab. 

 
19. Select Advanced from the Properties of Workspace dialog box. 

 
The IBM Rational Synergy dialog box appears.  

 
20. Open the Task-Based CM page, and then select Complete Task to check in your 

current task.  
 

 

 
 
 

21. After check in task is completed. Click OK. 
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22. Click OK to the Properties of Workspace dialog. 
 

23. Refresh status by selecting Refresh Status from the Workspace menu. 
 
Note: Refresh status operation may take a while. Please wait while updating SCC 
status. See the status bar at the bottom of the PowerBuilder, wait until the status 
states Ready. 
 

24. To baseline the project, you must have the build manager or admin role. If you do not 
have either role, make sure all the tasks are completed and all the files in your IBM 
Rational Synergy project are checked in. Now you can ask your Build Manager or 
Administrator to baseline your project. Baseline projects are in a static state (released, 
integrate, etc.). 

Setting up a development project  
You must have a working project to do a development work. And all the PBW, PBL and 
PBT files must be checked out prior working. Here are the steps you need to follow to set 
up a development project: 

 
1. Start IBM Rational Synergy.  

 
2. Open the baseline project, and then copy it.  

 
3. In your working project, check out all PBW, PBT and PBL files and any other files that 

you wish to modify. 
 

4. Check out all the DLLs and executables that you will modify. 
 

5. Start PowerBuilder, and then open your workspace.  
 

6. Use the Properties of Workspace dialog box to connect to IBM Rational Synergy.  
 

Once the connection is established, you are ready to work and perform source control 
operations on your project. 
 

 

Adding new targets 

 If you want to add more PBL files into your workspace, follow these steps: 
 

1. Using IBM Rational Synergy, check out the PowerBuilder Workspace file PBW in 
your project. 

 
2. Create a folder under the Workspace folder to contain the new PBL file. 

 
3. Create the PBL file, and then build your project. 

 
4. Use Sync to modify the database. 

 
You can start this operation by clicking the Advanced button in the Source Control 
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page of the Properties of Workspace dialog box. This brings your new PBL file and 
other files into IBM Rational Synergy database. 

 
 

 
 
 

5. Resolve work area conflicts by keep work area changes from the Work Area 
Conflicts dialog box. After sync is completed. Click OK and then click OK to the to 
the Properties of Workspace dialog box. 

 
6. Select the newly added PBL file, right click and select Add to Source Control. 

 
SCC Add to Source Control dialog box appears. 
 

7. Select option Select multiple files contained in this target and click OK. 
 

8. Select all files from the Add to Source Control dialog and click OK. 
 

This exports all the library entries and adds to IBM Rational Synergy database. 
 
All the library entries of the newly added PBLs are in IBM Rational Synergy. Now you 
can check in your task and check out the PBL file using a new task. 
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Using task-based CM 

Whenever you check out a library entry, the check out operation is recorded under your 
current task. You should have a current task before you check out files. When you are done, 
you should complete your current task instead of checking in the individual files. To complete 
a task or to create a task, access the Properties of Workspace dialog box, and then click 
Advanced. Then go to the Task-Based CM page of the IBM Rational Synergy dialog box.   

 

  

Setting up a build management project  
A build management project is typically used for building an application and making it 
available for testing and validation. With PowerBuilder, you use the Deploy operation to 
build the executables and DLLs.  
Copying a build management project is no different than a development project. The 
only difference is you copy it while you are in the build manager role.  

 
1. Start IBM Rational Synergy.  

 
2. Open the baseline project, and then copy it.  

 
3. In your working project, check out all PBW, PBT and PBL files and any other files 

that you wish to modify. 
 

4. Also check out all the DLLs and executables that you will modify. 
 

5. Start PowerBuilder, and then open your workspace.  
 

6. Use the Properties of Workspace dialog box to connect to IBM Rational 
Synergy.  

 
7. Update your project. 

 
You can start this operation by clicking the Advanced button in the Source Control 
page of the Properties of Workspace dialog box. This operation brings into your 
Workspace changes made by all team members. 
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Now you are ready to rebuild and deploy the project.  

   

Releasing a project 
 

A build management prep project is used to test and build the application. When the 
project is finished for a particular release, the build manager transitions the project from 
the prep state to the released state. This freezes the project so that no further 
modifications can be made. All PBL files are also checked in.  Optionally, you can set the 
PBLs, DLLs and EXEs as product. 
 
For details, refer to the IBM Rational Synergy documentation on the IBM Rational 
Synergy Support web site 
(http://www.ibm.com/software/awdtools/synergy/support/). 
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Changes since Release 2.0 
 
See the PowerBuilder Help to read about the Source Control Enhancements in 
PowerBuilder 10.5. 
  
Changes to this interface release are listed below: 
 

• This version of the interface supports IBM Rational Synergy 7.1. 
• The version of the interface memorizes the most recent IBM Rational Synergy 

login information such as user name, database path and server. 
 

 

 

 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



Page 24 of 27 

Appendix A – Conversion process for 
PowerBuilder SCC projects 
 

Converting PowerBuilder 7.0 projects to 8.0 
 
If you have PowerBuilder 7.0 projects controlled in IBM Rational Synergy, you cannot use 
them when you convert to the PowerBuilder 8.0 integration. 
 
Follow these steps to convert PowerBuilder 7.0 projects to PowerBuilder 8.0: 
 
1. Access your project from IBM Rational Synergy. 
2. Build your project using PowerBuilder 7.0 (optional). 
3. Use PowerBuilder 8.0 to build the same project. 
4. Migrate the project to IBM Rational Synergy as a different project. 

 

Converting PowerBuilder 8.0 projects to 9.0 
 
If you have PowerBuilder 8.0 projects controlled in IBM Rational Synergy, you can open them 
in PowerBuilder 9.0. However, PowerBuilder 9.0 makes changes to project files. Before 
opening the project, check out all PBW, PBL, PBT, DLL, and EXE files. PowerBuilder 
automatically converts these files. 
 

Converting PowerBuilder 9.0 projects to 10.5 
 
If you have PowerBuilder 9.0 projects controlled in IBM Rational Synergy, you can open them 
in PowerBuilder 10.5. However, PowerBuilder 10.5 makes changes to project files. Before 
opening the project, check out all PBW, PBL, PBT, DLL, and EXE files. PowerBuilder 
automatically converts these files. 
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Appendix B 
Notices 

This information was developed for products and services offered in the 
U.S.A. IBM may not offer the products, services, or features discussed in this 
document in other countries. Consult your local IBM representative for 
information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or 
imply that only that IBM product, program, or service may be used. Any 
functionally equivalent product, program, or service that does not infringe any 
IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, 
program, or service. 
 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant 
you any license to these patents. You can send written license inquiries to: 
 
IBM Director of Licensing  
IBM Corporation  
North Castle Drive  
Armonk, NY 10504-1785 
U.S.A. 
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 
 
IBM World Trade Asia Corporation  
Licensing  
2-31 Roppongi 3-chome, Minato-ku  
Tokyo 106-0032, Japan 
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow 
disclaimer of express or implied warranties in certain transactions. Therefore, 
this statement may not apply to you. 
 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will 
be incorporated in new editions of the publication. IBM may make 
improvements and/or changes in the product(s) and/or the program(s) 
described in this publication at any time without notice. 
 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of 
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those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own risk. 
 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. Licensees of this 
program who wish to have information about it for the purpose of enabling: (i) 
the exchange of information between independently created programs and 
other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 
 
Intellectual Property Dept. for Rational Software  
IBM Corporation  
1 Rogers Street  
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee.  
 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these 
measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through 
extrapolation. Actual results may vary. Users of this document should verify 
the applicable data for their specific environment. 
 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy 
of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be 
addressed to the suppliers of those products. 
 
This information contains examples of data and reports used in daily 
business operations. To illustrate them as completely as possible, the 
examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names 
and addresses used by an actual business enterprise is entirely coincidental. 
 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 

 

Trademarks 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
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other companies. A current list of IBM trademarks is available on the Web at 
Copy and Trademark information at www.ibm.com/legal/copytrade.html. 

Adobe, the Adobe logo, PostScript, and the PostScript logo are either 
registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States, and/or other countries.  

IT Infrastructure Library is a registered trademark of the Central Computer 
and Telecommunications Agency which is now part of the Office of 
Government Commerce 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino 
logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are 
trademarks or registered trademarks of Intel Corporation or its subsidiaries in 
the United States and other countries.  

Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.  

ITIL is a registered trademark, and a registered community trademark of the 
Office of Government Commerce, and is registered in the U.S. Patent and 
Trademark Office  

UNIX is a registered trademark of The Open Group in the United States and 
other countries.  

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. 
in the United States, other countries, or both and is used under license 
therefrom.  

Java and all Java-based trademarks and logos are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both.  

Other company, product or service names may be trademarks or service 
marks of others. 

 

 

 


